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CHAPTER 1
Getting Started
Macromedia Captivate is a professional software tool for quickly creating interactive 
demonstrations and simulations in a variety of formats including Flash (SWF) and EXE. Anyone 
who needs to develop online product demonstrations, software simulations for e-learning, or 
online tutorials for user support will find Captivate an ideal solution. Captivate includes 
everything you need to record actions in any application and instantly create a simulation.

Captivate enables you to add customized text captions, audio (voice-overs, background music, 
and sound effects), video, Flash animations, text animations, images, hyperlinks, and more to 
your movies. A small file size and high resolution make Captivate simulations and demonstrations 
easy to publish online or burn to CD for use in training, sales, marketing, or user support.

If you use Captivate to create e-learning content, you can add realistic, fully interactive question 
slides, buttons, click boxes, and text entry boxes. Captivate is SCORM 1.2 and 2004 certified and 
AICC compliant, allowing effortless integration with any Learning Management System (LMS), 
Macromedia Authorware, or Questionmark Perception.

What’s new in Macromedia Captivate

Macromedia Captivate provides major new features and enhancements, including the following:

• Control timing easily with a visual Timeline Save production time and visually control the 
timing of each slide element by dragging and dropping in the Timeline. Display multiple 
objects or even two or more captions simultaneously. Drag and drop Timeline layers to change 
the order of objects on a slide—the slide automatically updates to reflect the change.

• Preview slides instantly Make slide changes and see the results instantly by playing the slide 
without compiling or generating a preview. Use the playhead to preview a specific section of a 
slide, or to scrub and see the slide in slow motion.

• Capture effortlessly Create more realistic demonstrations with the improved capture 
mechanism that automatically switches on and off full motion recording for drag-and-drop 
actions. Web capture is now optimized and enhanced to capture screen shots after the web 
page has finished loading.
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• Speed up production with easy audio editing Record audio during the screen capture 
process to save development time. Mistakes can be edited out in the easy-to-use audio editor. 
Easily control volume, insert silent periods, and synchronize slide events precisely to the 
narration.

• Enhance the Macromedia Breeze experience Increase training effectiveness by adding 
interactive simulations to Breeze presentations and Breeze Live meetings. Every viewer 
becomes an active participant who can fully interact with the content. Deliver content through 
standard web browsers by publishing demonstrations directly to a Breeze server.

• Enhance projects in Macromedia Flash Take projects from Captivate to Flash for further 
development using the improved, powerful Flash export feature. Captivate also exports the 
playback controls and other objects such as full-motion slides and text animations.

• Improve quizzing Control the look and feel of quizzes to fit branding or match color 
schemes. Increase training effectiveness with time-limited questions and new quiz types such as 
matching, likert, and fill-in-the-blank.

• Leverage industry standards Leverage SCORM 2004 packaging and runtime 
communication. Captivate supports SCORM 2004, SCORM 1.2 and AICC, to easily deploy 
simulations through any LMS. Generate demonstrations and simulations that are 508 
compliant to reach audiences with disabilities.

• Output high quality printed content Supply reviewers or end users with printed storyboards 
or documentation. The improved Microsoft Word output format now exports larger images.

• Work faster, edit more easily Save time and increase productivity with a multitude of 
usability enhancements such as the new Start Page, the option to snap the recording size to the 
application window or vice versa, the simplified recording dialog, and many more. Save 
development time by recording in simulation mode, which automatically adds scored user 
interactions with instructional feedback.

• Unicode support Use any font and encoding supported by the Windows operating system, 
including double-byte character sets.

• Localization In addition to English, German, French, and Japanese versions, Korean and 
Traditional Chinese versions of Captivate are now available.

Caution: When opening a Captivate project created with RoboDemo, note the following. Projects 
created with RoboDemo versions prior to version 4 use a .ncp or .fcz file extension. RoboDemo 4 
and 5 projects use the .rd or .fcz file extension. Captivate upgrades older projects as they are opened 
in Captivate and gives them the new Captivate file extension of .cp.
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Guide to Captivate instructional media

Captivate includes a variety of resources to help you learn the program quickly and become 
proficient in creating your own Captivate projects.

Captivate Help includes comprehensive information about using all aspects of Captivate. To view 
Captivate Help, open Captivate, and from the Help menu, select Captivate Help.

Using Captivate is a PDF version of the contents of Captivate Help, providing information on 
using Captivate commands and features. The PDF file is available on the Macromedia website.

Getting Started with Captivate provides an introduction to Captivate and the basic process of 
creating Captivate projects. A printed version of this manual is included with the boxed version of 
Captivate and a PDF version is available on the Macromedia website.

The Captivate Support Center at www.macromedia.com/support is updated regularly with the 
latest information on Captivate, plus advice from expert users, examples, topics, updates, and 
information on advanced topics.

Macromedia Devnet at www.macromedia.com/go/devnet/ provides tools, tutorials, and more for 
all Macromedia Products.
Guide to Captivate instructional media 7
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CHAPTER 2
Installing Captivate
This chapter describes the system requirements for running Captivate and explains how to 
install Captivate.

System requirements

To create movies with Captivate, your computer system should include the hardware, software, 
and accessories listed below.

System requirements:

• Microsoft Windows 2000 or Windows XP
• A 600-MHz Intel Pentium III processor or equivalent
• 128 MB of RAM (256 MB recommended)
• 100 MB of available disk space
• 800 x 600 resolution color display or better (1024 x 768, millions of colors recommended)

Software and accessories for publishing and recording:

• Internet Explorer 5.0 or later
• Flash Player 6 or later
• Microphone to record audio
• Speakers and sound card

Installing Macromedia Captivate

Installing Captivate is a simple and automated process. Check to make sure there is enough free 
disk space on your hard disk to meet the system requirements.

The installation program prompts you for the serial number for your copy of Captivate. After the 
Captivate product files are copied to your computer, you have the option to activate and register 
Captivate online. It is important to activate Captivate as soon as possible to enable all of the 
capabilities of Captivate.
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Registering is optional; it provides you with many benefits such as priority upgrades, new 
product bulletins, and timely e-mail messages about product updates and new content at 
www.macromedia.com.

To install Captivate:

1. Close all programs.

2. Do one of the following:

■ If you have a Captivate CD, insert the CD into the computer's CD-ROM drive and then 
double-click the Captivate installer icon.

■ If you are installing Captivate from the Internet, double-click on the downloaded file.
3. Follow the onscreen instructions.

4. Click Install on the last screen of the wizard.

Macromedia Captivate is installed on the computer.
5. Click Finish.

When you install Captivate, the product is a 30-day trial version until you activate the software. It 
is very important to activate the software within 30 days of installing. The activation process 
verifies your product serial number and license. (For details, visit the Macromedia Product 
Activation Centers at www.macromedia.com/go/activation/.)

To activate Macromedia Captivate:

1. Double-click on the Macromedia Captivate icon on the desktop.

The Macromedia Product Activation Wizard appears.
2. Follow the onscreen instructions and enter your serial number.

The activation process begins. When the process is complete, a message appears stating that the 
software was successfully activated.

3. Click Continue.

4. (Optional) Register with Macromedia. Type in your name and e-mail address and click 
Register. A web page appears and confirms your registration.
10 Chapter 2:  Installing Captivate
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CHAPTER 3
Basics
Creating projects with Captivate is easy and fast. Following are the basic steps involved in 
creating movies:

• Plan your movie using storyboards, scripts, or whatever organizational materials are 
appropriate.

• Set initial recording options and movie preferences.
• Record your movie. Capture onscreen action of all kinds. You can create a new movie from 

scratch or use a template. You can even import other file types into Captivate movies. 
• Add captions, images, sound, animated text, and countless other options to your movie. 

Customize what you add for your own particular needs. 
• If necessary, change movie and object timing using the Timeline.
• Preview the movie.
• Publish the movie in any of a variety of formats. 

About the work environment

Captivate is designed so you can create a movie easily. Following is an overview of the Captivate 
work environment. 

Views

Captivate has two main views: Storyboard view and Edit view (with the Filmstrip).

• Storyboard This view appears when you open a movie from the Start Page. The movie opens 
with small images representing the slides that constitute the movie. Storyboard view provides 
an easy way to see all of the slides within a movie at a glance. It also enables you to see the flow 
of the movie. You can change the properties of multiple slides at the same time: to select 
multiple slides, hold down the Shift or Control key while clicking on slides; to select all slides, 
press Control+A.
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• Edit This view appears when you double-click on a slide in Storyboard view. After recording 
a Captivate movie, you will probably spend most of your time in Edit view, because this is the 
view in which you add movie objects (such as captions, images, click boxes, and audio). Using 
this view, you can make many changes to a slide, such as altering the mouse movement and 
changing the mouse pointer. Finally, Edit view contains the optional Filmstrip. The Filmstrip 
lets you see all of the slides in a movie, even while editing an individual slide in Edit view. 

Timeline

The Timeline is a visual representation of all objects on slides. The Timeline provides an easy way 
to view, at a high level, all objects on a slide and their relationship to each other. With the 
Timeline, you can organize objects and precisely control the timing of objects. For example, on a 
slide that contains a caption, an image, and a highlight box, you can display the caption, then the 
image four seconds later, and then the highlight box two seconds after that. The Timeline also 
shows any audio associated with the slide or with objects on the slide, letting you easily coordinate 
the timing of audio with objects.

Toolbars and menus

In both views, the program contains menus and toolbars at the top of the program window. 
Context (right-click) menus are also available throughout the program.

• Menu bar Click a menu at the top of the program window (for example, File, Insert, or 
Options) to see the related menu commands.   

• Context menus Place the mouse pointer in the pane in which you want to work. Press the 
right mouse button, and select a command from the menu.

• Toolbars Click an icon on any of the program toolbars as a shortcut to dialog boxes and 
actions. All of the toolbar options (for example, showing/hiding toolbars, toolbar location, and 
so on) for a given view are located in the View menu. 

Tip: For maximum editing space, open a movie and click F11 to display Captivate in full-screen edit 
mode.

Recording movies

Captivate makes creating a new movie easy. When you record a Captivate movie, you use the 
application or website you want to demonstrate as you would normally, by moving the mouse, 
using the keyboard, and navigating through menus. As you work, Captivate captures the onscreen 
action automatically, or you can capture screen shots manually. When you finish recording, you 
can set options and add components such as text captions, audio, images, and highlight boxes.

You can create several kinds of Captivate movies. The recording process is similar for each type, 
but each has some unique options.

• Application Records all selected action within a single running application.
• Custom Records all selected action within a custom-defined area. If you select this option, set 

a custom size in the Width and Height boxes or select a commonly used size from the Preset 
Size pop-up menu.
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• Full Screen Records all onscreen action. This option is especially useful if you need to 
capture action taking place in multiple applications.

• Blank Records a blank frame in a size you specify. This option is useful if you want to create 
an empty movie and then import Microsoft PowerPoint slides, slides from another movie, or 
images.

• Image movie Provides you with an easy way to create a Captivate movie made up of images. 
When the resulting movie is published and viewed, it looks like a slide show.

Recording a new application movie

Use this recording option to record all action within a single running application. You can start 
any type of application such as a word processing program, a graphics program, a spreadsheet 
program, or any kind of software you have, and record the action that takes place within the 
application.

To record a new application movie:

1. Open the application you want to record. (You must do this before recording.)

2. Open Captivate. 

3. On the Start Page, click Record or create a new movie. 

The New movie options dialog box appears. 
4. Select Application and click OK.

The Recording window appears.
5. In the Record specific window pop-up menu, select the application to record.

6. (Optional) Select Record narration to record audio as you record the movie.

7. (Optional) Click Options to set a wide variety of recording options, including the capability to 
automatically record the movie and automatically generate text captions.

8. (Optional) If necessary, change the size and position of the window. You can resize the window 
by selecting one of the sizing handles on the red frame and dragging it. To change the location 
of the window, move the mouse over the red frame until a four-point arrow appears, and then 
drag the entire window to a new position. You can also click Snap red recording area to fit select 
window to quickly change the size of the recording area to match the size of the application.

9. When you finish setting options, click Record.
Recording movies 13



10. Captivate begins recording the onscreen action. 

■ If you are automatically recording (that is, you selected the Enable auto recording option in 
step 7), Captivate automatically captures a screen shot every time you perform an action, 
such as selecting a menu, clicking a button, or typing text. 

Note: When you are auto recording, you can take a screen shot manually at any time by 
pressing the Print Screen key. This is particularly useful if you are capturing a website that 
contains many pop-ups, frames, and special effects that are sometimes not auto recorded. If 
you see a special effect or change take place on a web page you are recording, but do not hear 
the camera shutter sound, press Print Screen to take a screen shot manually.

■ If you are manually recording (that is, you did not select the Enable auto recording option 
in step 7) press the Print Screen key (or other designated capture key) to capture screen 
shots. 

Use the application as if you were demonstrating your actions to someone. If you have sound 
enabled on your computer and the option is activated, you will hear a camera shutter sound 
when screen shots are captured.

Note: When you record any onscreen action, it is best to perform the action more slowly than you 
would normally. For example, if you are recording keyboard action, type text slowly. 

11. When you finish recording, press the End key (or other designated key) to end recording.

The slides are generated and your new movie appears in the Captivate Storyboard view. If any 
drag-and-drop actions were recorded and full motion slides created, you will see the full 
motion slides displayed in Storyboard view with a movie camera icon in the lower right corner 
of the slide.

Tip: If you need to pause recording, press the Pause/Break key. To restart recording, press Pause/
Break again.

Editing movies

After recording a movie, you have many options for enhancing the movie so it is as informative 
and interesting for viewers as possible. You can add text captions to point out important areas on 
a slide or use a highlight box instead. Make movies interactive by including click boxes or text 
entry boxes. Add the element of sound to movies by importing background music or record a 
voice-over narration track. Experiment with different options to incorporate the most appropriate 
elements into your movies.

About objects

Objects are different elements that you can add to Captivate slides. Captivate has many different 
types of objects: 

• Text captions Text captions are text "bubbles" that describe a slide or provide extra 
information.

• Highlight boxes Highlight boxes can be used as emphasis, and can show users where to focus 
attention or enter data. 
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• Images Images add a new dimension to movies and can be used for a variety of purposes 
including splash screens, pointers, and backgrounds.

• Rollover captions A rollover caption consists of a caption and a rollover area (the "hot" area). 
A rollover caption appears when the user moves the mouse over the hot area. 

• Rollover images A rollover image consists of an image and a rollover area (the "hot" area). A 
rollover image appears when the user moves the mouse over the hot area.

• Animations Adding animations is an easy way to add content and interest to Captivate 
movies using information you already have. You can import animated GIF files, SWF files, 
FLA files, and AVI files.

• Animated text Incorporating Captivate animated text into movies instantly gives projects a 
high-quality, professional look. Animated text is especially effective on the first and last slides 
of movies.

The following objects all add interactivity to movies:

• Click boxes Click boxes are clickable boxes that add interactivity and can be used to 
demonstrate an application's capabilities by requiring users to click on a menu or button.

• Text entry boxes Text entry boxes allow you to increase Captivate movie interaction quickly 
and easily. For example, you can use text entry boxes to ask simple quiz questions.

• Buttons Buttons increase the interactivity of Captivate movies and can be added, sized, and 
located on a slide as required. 

About text captions

Text captions are useful tools that draw attention to specific areas in a slide. For example, you can 
use text captions to point out menu items or icons. You can also use text captions to focus user 
attention on easily overlooked details. If you do not use voice-over narration in a movie, you can 
use text captions to provide a similar function—text captions can "speak" to the user. 

You decide how text captions appear (font, size, color, and so on). Captivate provides a wide 
variety of predefined text caption styles, but you can also create custom text caption styles that 
match your company or organization appearance.

It is easy to add text captions to movie slides manually, but to create text captions very quickly you 
can have Captivate automatically generate text captions based upon what is recorded. For 
example, if you record the mouse clicking on the Edit menu, Captivate can automatically create a 
text caption that says "Select the Edit menu" and place the text caption on the exact slide showing 
the action.

Adding captions

You can use text captions to "talk" to users or to point out specific items on a slide. It is easy to 
add a text caption to a slide and to edit the text caption so it looks exactly the way you want.

To add a text caption:

1. Open a Captivate movie.

2. Double-click on the slide to which you want to add a text caption.
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3. From the Insert menu, select Text Caption.

The Text Caption Properties dialog box appears.
4. On the Text Caption tab, set the following properties: 

■ Caption type Click the pop-up menu to select a text caption type. Each text caption type 
is named and a small thumbnail image shows what the text caption looks like.

■ Font Click the pop-up menu to select a font for the text caption.
■ Size Click the pop-up menu to select a font size for the caption text.
■ Color Click the color box to select a font color for the caption text.
■ Caption style Click one of the five text caption types. Many of the text caption styles 

contain text captions with directional callouts so you can select a text caption that points in 
the most appropriate direction.

■ Display options If you want, set additional display options such as bold, italic, or 
underlined text, and text justification.

■ Type caption text here Enter the caption text exactly as you want it to appear.
■ Apply properties to all captions in the movie Select this option to apply the changes you 

made on this tab to all text captions in the movie. Properties applied to all text captions are 
caption style, font type, font size, font color, and transition. Text and text properties (bold, 
center, and so on) and display time are not applied to all text captions, but remain as set for 
each individual text caption.

Note: If you change the settings on this dialog, they become the default settings and any new 
captions you create use the new settings.

5. Click the Options tab and set the following options:

■ Display time [#] seconds Specify the total number of seconds the text caption should 
appear.

■ Appear after [#] seconds Specify the number of seconds that should pass before the text 
caption appears on the slide.

■ Display for rest of movie Select this option to display the text caption on this slide and 
keep displaying the text caption until the end of the movie.

■ Effect Click the pop-up menu and select a transition effect for the text caption. Select a 
fade in or fade out option, or select No transition.

■ Apply effect to all captions in the movie Select this option to apply the changes you 
made on this tab to all the text captions in the movie.

6. If you want to add audio to the text caption, click the Audio tab.

7. When you finish, click OK.

The text caption appears on the slide.
8. Size and drag the text caption as you like.

Tip: If you add a transparent text caption, avoid using bold text. Regular text appears clearer than 
bold text on most monitors.
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Adding highlight boxes

Captivate lets you add highlight boxes to spotlight areas within a slide. You can think of a 
highlight box as the online equivalent of a highlighter pen used on paper. Add highlight boxes to 
show users where to focus attention or enter data, or simply as emphasis. You can control the size, 
color, transparency, and timing for highlight boxes.

To add a highlight box:

1. Open a Captivate project.

2. Double-click on the slide to which you want to add a highlight box.

3. From the Insert menu, select Highlight Box.

The New Highlight Box dialog box appears.
4. On the Highlight Box tab, set the following options:

■ Frame color This is the border color for the highlight box. Click the color box to change 
the color.

■ Fill color This is the fill color for the highlight box. Click the color box to change the 
color.

■ Frame width This is the width for the border of the highlight box. 
■ Fill transparency This is the degree of transparency for the fill color. Select a value from 

0% to 100%. A value of 10% is less transparent (more solid) than a value of 90%.
■ Preview This area displays the settings you selected above.
■ Apply properties to all highlight boxes in the movie Select this option to apply the 

changes you made in this tab to all the highlight boxes in the movie.
5. Click the Options tab and set the following options:

■ Display time [#] seconds Type a number or use the arrows to set the total number of 
seconds the highlight box should appear.

■ Appear after [#] seconds Type a number or use the arrows to set the number of seconds 
that should pass before the highlight box appears on the slide.

■ Display for rest of movie Select this option to display the highlight box on this slide and 
keep displaying the highlight box until the end of the project.

■ Effect Use the pop-up menu to select a transition effect for the highlight box. Select a fade 
in or fade out option, or select No transition. If you select fade in or fade out, use the arrows 
to set the exact amount of time (in seconds) for the effect.

■ Apply effect to all highlight boxes in the movie Select this option to apply the changes 
you made in this tab to all the highlight boxes in the movie.

6. If you want to add audio to the highlight box, click the Audio tab.

7. Click OK. 

The highlight box appears on the slide.
8. Size and drag the highlight box as desired.
Editing movies 17



Adding click boxes

Captivate lets you add another level of interactivity to projects by using click boxes. Click boxes 
are clickable boxes that you can size and position. You can use click boxes to demonstrate an 
application's functionality, for example, by requiring users to click a menu or button. Of course, 
you determine what happens after the user performs a successful click. For example, the movie 
can advance to the next slide, open a URL, or send an e-mail message.

To add a click box: 

1. Open a Captivate project.

2. Double-click on the slide to which you want to add a click box.

3. From the Insert menu, select Click Box. 

The Click Box dialog box appears.
4. Select the Click Box tab. 

This tab lets you determine how the movie responds to user interaction. The options are 
divided into two basic categories: what happens when the user clicks inside the click box and 
what happens when the user clicks outside the click box.
If the user clicks inside the click box: 
■ On success Specify what should happen after a user clicks inside the box. You can select 

Continue, Go to previous slide, Go to next slide, Jump to slide, Open URL or file, Open 
other movie, Send e-mail to, Execute JavaScript, or No Action. 

Note: If you select Open URL or file or Open other movie, click the pop-up menu to select 
the window in which the URL, file, or movie should appear; choose from Current, New, 
Parent, and Top. (If you choose New, Parent, or Top, you also have the option to Continue 
playing the original movie when the URL, file, or movie opens.)

Note: If you select Send e-mail to, you have the option to Continue playing the movie while 
the e-mail message is prepared and sent.

Note: If you select the Open URL or file option and specify a URL, the URL is visible when 
you edit the slide in Captivate. However, it will not be visible to the user. To show the URL, 
create a simple image with the URL text on the image, add the image to your slide, and place a 
click box over the image.

■ Continue Depending upon the type of action you selected above, this box changes to let 
you enter destination information. 

If the user clicks outside the click box: 
■ Allow user [#] attempts Click the arrows to select the number of attempts a user can 

make before another action takes place. (The Infinite attempts option is selected by default. 
To enter a specific number of attempts, first deselect the Infinite attempts option.)

■ Infinite attempts Select this option to give users an unlimited number of attempts.
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■ After last attempt Specify what should happen after the last attempt. You can select 
Continue, Go to previous slide, Go to next slide, Jump to slide, Open URL or file, Open 
other movie, Send e-mail to, Execute JavaScript, or No Action. 

Note: If you select Open URL or file or Open other movie, click the pop-up menu to select 
the window in which the URL, file, or movie should appear; choose from Current, New, 
Parent, and Top. (If you choose New, Parent, or Top, you also have the option to Continue 
playing the original movie when the URL, file, or movie opens.)

Note: If you select Send e-mail to, you have the option to Continue playing the movie while 
the e-mail message is prepared and sent.

Note: If you select the Open URL or file option and specify a URL, the URL is visible when 
you edit the slide in Captivate. However, it will not be visible to the user. To show the URL, 
create a simple image with the URL text on the image, add the image to your slide, and place a 
click box over the image.

■ Continue Depending upon the type of action you selected above, this box changes to let 
you enter destination information. 

Set shortcut key:

Click Select keys to choose a key combination for users to press when submitting responses. 
The current shortcut is displayed to the left of the button.

Note: If your Captivate movie will be displayed in a browser, set shortcut keys that will not 
conflict with common browser shortcuts. For example, F1 is frequently used as a keyboard 
shortcut to display help.

5. Click the Options tab. This tab lets you design how the click box looks. Select from the 
following options:

■ Display time [#] seconds Specify the total number of seconds the click box should 
appear.

■ Appear after [#] seconds Specify the number of seconds that should pass before the click 
box appears on the slide. 

■ Hint caption Select this option to include a hint caption. (The hint caption appears when 
users move the mouse over the click box.)

■ Success caption Select this option to include a success caption (for example, 
Congratulations!).

■ Failure caption Select this option to include a failure caption (for example, Sorry, please 
try again).

■ Show hand cursor over hit area Select this option to have the hand appear when a user 
moves the mouse over the click box. 

■ Stop audio when clicked Select this option if you want the audio to stop playing when 
the user clicks the click box. This option stops only slide audio, not background audio. Also, 
only a mouse click on the click box stops the audio; using a shortcut key combination does 
not stop the audio.

■ Pause movie until user clicks Select this option if you want the project to stop playing 
until the user clicks the click box.
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■ Double mouse click Select this option to allow users to double-click the click box. 
■ Pause for success/failure captions Select this option to have the movie pause until all 

success and failure captions (see explanations for captions above) have displayed for the user 
to read.

6. If you want to add audio to the click box, click the Audio tab. Select from the following options:

■ Click the Play button to play the audio file.
■ Click the Stop button to stop playing the audio file.
■ Click the Delete button to remove the audio file from the click box.
■ Edit Displays the Edit Audio dialog box. This dialog box lets you edit the audio file in a 

variety of ways, such as inserting silent periods and adjusting the volume.
■ Audio Displays the name of the audio file, if any, associated with the click box.
■ Record new Click to open the Record Audio dialog box. (Recording audio requires some 

basic equipment.)
■ Import Displays the Import Audio dialog box. This dialog box lets you browse to an audio 

file and import it. 
■ Audio library Click to open the Audio Library, which lists all audio files that are already 

part of the currently open Captivate project.
■ Fade in [#] seconds Specifies the number of seconds for the audio to fade in to full 

volume. 
■ Fade out [#] seconds Specifies the number of seconds for audio to fade out to silence.

7. If you want to keep score for the click box or coordinate the score with an LMS, click the 
Reporting tab. Select from the following options:

■ Report answers This option communicates quiz answers to an LMS.
■ Objective ID This is an optional parameter. If the click box question is related to an 

objective set in your LMS, enter the objective here.
■ Interaction ID If you want the Captivate movie to send tracking information to your 

LMS, you must use the interaction ID specified by your LMS.
■ Weighting Weighting signifies the relative importance of a click box question. You can 

enter any numeric value (without decimals). If all questions have the same value ("1", for 
example), they are scored equally. If you want to set different values for different questions, 
keep in mind that weights are relative to each other. So, a question assigned a weight of "2" 
has a value twice as high as a question with a weight of "1." You can use this feature to give 
introductory questions a lower value and advanced questions a higher value.

8. Click OK. 

The click box appears on the slide.
9. Size and drag the click box as desired. 

10. If you selected the Success, Failure, or Hint caption options, double-click the text boxes to edit 
the text.
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Adding text entry boxes

Text entry boxes let you increase Captivate project interaction quickly and easily. For example, 
you can use text entry boxes to ask simple quiz questions.

To add a text entry box:

1. Open a Captivate project.

2. Double-click on the slide to which you want to add a text entry box.

3. From the Insert menu, select Text Entry Box. 

The Text Entry Box dialog box appears.
4. Click the Text Entry Box tab. This tab allows you to determine how the movie responds to user 

interaction. The options are divided into two basic categories: what happens when the user 
enters text correctly and what happens when a user enters text incorrectly in the text entry box.

If the user enters the text correctly:

■ Correct Entries Enter the correct text here. You can enter multiple correct answers.
■ Font Opens the Font dialog box, which lets you set font, font styles, font size, and font 

effects for the text.
■ Add Opens a new entry box in which you can enter another correct entry.
■ Delete Removes the selected entry from the list.
■ On success Specify what should happen after a user enters the correct text in the text 

entry box. You can select Continue, Go to previous slide, Go to next slide, Jump to slide, 
Open URL or file, Open other movie, Send e-mail to, Execute JavaScript, or No Action.

Note: If you select Open URL or file or Open other movie, click the pop-up menu to select 
the window in which the URL, file, or movie should appear; choose from Current, New, 
Parent, and Top. (If you choose New, Parent, or Top, you also have the option to Continue 
playing the original movie when the URL, file, or movie opens.)

Note: If you select Send e-mail to, you have the option to Continue playing the movie while 
the e-mail message is prepared and sent.

Note: If you select the Open URL or file option and specify a URL, the URL is visible when 
you edit the slide in Captivate. However, it will not be visible to the user. To show the URL, 
create a simple image with the URL text on the image, add the image to your slide, and place a 
click box over the image.

■ Continue Depending upon the type of action you selected above, this box changes to let 
you enter destination information.

If the user enters the text incorrectly:

■ Allow user [#] attempts Click the arrows to select the number of attempts a user can 
make before another action takes place. (The Infinite attempts option is selected by default. 
To enter a specific number of attempts, first deselect the Infinite attempts option.)

■ Infinite attempts Select this option to give users an unlimited number of attempts.
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■ After last attempt Specify what should happen after the last attempt. You can select 
Continue, Go to previous slide, Go to next slide, Jump to slide, Open URL or file, Open 
other movie, Send e-mail to, Execute JavaScript, or No Action.

Note: If you select Open URL or file or Open other movie, click the pop-up menu to select 
the window in which the URL, file, or movie should appear; choose from Current, New, 
Parent, and Top. (If you choose New, Parent, or Top, you also have the option to Continue 
playing the original movie when the URL, file, or movie opens.)

Note: If you select Send e-mail to, you have the option to Continue playing the movie while 
the e-mail message is prepared and sent.

Note: If you select the Open URL or file option and specify a URL, the URL is visible when 
you edit the slide in Captivate. However, it will not be visible to the user. To show the URL, 
create a simple image with the URL text on the image, add the image to your slide, and place a 
click box over the image.

■ Continue Depending upon the type of action you selected above, this box changes to let 
you enter destination information.

Set shortcut key:

Click Select keys to choose a key combination for users to press when submitting responses. 
The current shortcut is displayed to the left of the button.

Note: If your Captivate movie will be displayed in a browser, set shortcut keys that will not 
conflict with common browser shortcuts. For example, F1 is frequently used as a keyboard 
shortcut to display help.

5. Select the Options tab. This tab provides you with many ways to customize your text entry box. 
Select from the following options:

■ Display time [#] seconds Specify the total number of seconds the text entry box should 
appear.

■ Appear after [#] seconds Specify the number of seconds that should pass before the text 
entry box appears on the slide.

■ Effect Click on the pop-up menu and select a transition effect for the text entry box. 
Select a fade in or fade out option, or select No transition.

■ Apply effect to all text entry boxes in the movie Select this option to apply the changes 
you made in this tab to all the text entry boxes in the project.

■ Transparency This is the degree of transparency for the text entry box. Select a value from 
0% to 100%. A value of 10% is less transparent (more solid) than a value of 90%.

Note: The transparency effect does not appear when you view the text entry box in Edit view. 
To test the transparency effect, press F4 to preview the slide.

■ Hint caption Select this option to include a hint caption. (The hint caption appears when 
users move the mouse over the text entry box.)

■ Success caption Select this option to include a success caption (for example, 
Congratulations!).

■ Failure caption Select this option to include a failure caption (for example, Sorry, please 
try again).
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■ Show button Select this option to display a button with text such as ENTER or 
COMPLETE. (To add or edit button text, view the slide in Edit view and double-click the 
button to open the Button dialog box.)

■ Pause for success/failure captions Select this option to have the movie pause until all 
success and failure captions (see explanations for captions above) have displayed for the user 
to read.

■ Show text box frame Select this option if you want the text entry box frame to be visible 
to users. If you do not select this option, only the text is displayed.

■ Password Select this option if you want to mimic a password field.
■ Show for the entire slide Select this option to have the text entry box appear for the entire 

amount of time that the slide appears.
■ Case-sensitive Select this option to make the text entry box case-sensitive. This means 

that users must provide answers with the correct combination of lowercase and uppercase 
letters.

6. If you want to add audio to the text entry box, click the Audio tab. Select from the following 
options:

■ Click the Play button to play the audio file.
■ Click the Stop button to stop playing the audio file.
■ Click the Delete button to remove the audio file from the text entry box.
■ Edit Displays the Edit Audio dialog box. This dialog box lets you edit the audio file in a 

variety of ways, such as inserting silent periods and adjusting the volume.
■ Audio Displays the name of the audio file, if any, associated with the text entry box.
■ Record new Click to open the Record Audio dialog box. (Recording audio requires some 

basic equipment.)
■ Import Displays the Import Audio dialog box. This dialog box lets you browse to an audio 

file and import it. 
■ Audio library Click to open the Audio Library, which lists all audio files that are already 

part of the currently open Captivate project.
■ Fade in [#] seconds Specifies the number of seconds for the audio to fade in to full 

volume. 
■ Fade out [#] seconds Specifies the number of seconds for audio to fade out to silence. 

7. If you want to keep score for the text entry box or coordinate the score with an LMS, click the 
Reporting tab. Select from the following options:

■ Report answers This option communicates quiz answers to an LMS.
■ Objective ID This is an optional parameter. If the text entry box question is related to an 

objective set in your LMS, enter the objective here.
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■ Interaction ID If you want the Captivate movie to send tracking information to your 
LMS, you must use the interaction ID specified by your LMS.

■ Weighting Weighting signifies the relative importance of a text entry box question. You 
can enter any numeric value (without decimals). If all questions have the same value ("1", 
for example), they are scored equally. If you want to set different values for different 
questions, keep in mind that weights are relative to each other. So, a question assigned a 
weight of "2" has a value twice as high as a question with a weight of "1." You can use this 
feature to give introductory questions a lower value and advanced questions a higher value.

8. Click OK. 

A text entry box appears on the slide. 
9. Size and drag the text entry box as desired.

10. If you selected the Success, Failure, or Hint caption options, double-click the text boxes to edit 
the text.

About audio

Captivate lets you add narration, music, step-by-step instructions, or almost any sound to your 
projects. You can use audio as critical direction, emphasis, or background effect. In general, sound 
can be as individual and flexible as any other movie component.

Audio can be used in Captivate projects in a variety of ways. For example, you can do the 
following:

• Add a background track that plays for the duration of the movie.
• Add sound to an individual slide.
• Add sound to a specific object, such as a caption, click box, highlight box, or button.
• Use all three of the above options in the same project.

Captivate lets you record your own audio files (using some simple equipment) or import existing 
files. You can record audio files at the same time the movie is recorded, or you can add an audio 
file later. Imported files can be in WAV or MP3 format. (If you add a WAV file to a movie, 
Captivate automatically converts the WAV file to MP3 format.)

After audio has been added to a movie, you can adjust the timing of objects to fit the sound file 
precisely. Captivate also contains features that enable you to add silent periods to audio files and 
to normalize audio for all slides so the sound level is consistent.

Tip: Captivate contains a gallery that has buttons, sounds, and animations (in SWF format) for you to 
use in your projects. By default, the gallery is stored in the following location when you install 
Captivate: C:\Program Files\Macromedia\Captivate\Gallery.

Adding existing audio

You can quickly add audio to a movie if you already have audio files in WAV or MP3 format. 
Simply import the files and use them as opening music, background narration, instructions, or 
any other purposes.

Note: When WAV files are imported into Captivate movies, they are automatically converted to MP3 
files.
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To add audio to a slide:

1. Open a Captivate project.

2. Do one of the following:

■ In Storyboard view, select a slide. From the Audio menu, select Import. 
■ In Edit view, from the Audio menu, select Import. 
The Import Audio dialog box appears.

Tip: Captivate contains a gallery that has buttons, sounds, and animations (in SWF format) for you 
to use in your projects. By default, the gallery is stored in the following location when you install 
Captivate: C:\Program Files\Macromedia\Captivate\Gallery.

3. Navigate to the audio file (WAV or MP3) you want to add to the slide, select the audio file, and 
click Open.

4. (Optional) If the playing time of the audio file is longer than the playing time of the slide, a 
dialog box appears asking if you would like to edit slide timing. Click Yes to open the Edit Audio 
Timing dialog box.

Recording audio while creating a movie

Captivate lets you record an audio track at the same time you record a new Captivate movie. This 
can be a very efficient way to create a full-featured movie quickly.

In the process below, the steps explain how to record audio while creating a Captivate movie 
about an application. The process is similar if you create a custom size or full-screen Captivate 
movie.

To record audio and a new Captivate movie at the same time:

1. Open the application you want to record. (You must do this before recording.)

2. Prepare your recording equipment.

3. Open Captivate. 

4. On the Start Page, click Record or create a new movie. 

The New movie options dialog box appears. 
5. Select Application and click OK.

The Recording window appears.
6. In the Record specific window pop-up menu, select the application to record.

7. Select Record narration.

8. (Optional) Click Options to set a wide variety of recording options, including the capability to 
automatically capture screen shots and automatically generate text captions.

9. (Optional) If necessary, change the size and position of the window. You can resize the window 
by selecting one of the sizing handles on the red frame and dragging it. To change the location 
of the window, move the mouse over the red frame until a four-point arrow appears, and then 
drag the entire window to a new position. You can also click Snap red recording area to fit select 
window to quickly change the size of the recording area to match the size of the application.
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10. When you finish setting options, click Record.

If this is the first time you are recording audio, a dialog box appears asking if you would like to 
test audio levels. Click Yes to calibrate the recording device for optimal recording. Follow the 
instructions and when you finish, click OK.

11. Captivate begins recording the onscreen action. 

■ As you record the movie, speak into your microphone or recording device to create an audio 
soundtrack. For example, you can explain the actions you are taking or read the text on 
captions. 

■ If you are automatically recording the movie (that is, you selected the Enable auto recording 
option in step 8), Captivate automatically captures a screen shot every time you perform an 
action, such as selecting a menu, clicking a button, or typing text.

■ If you are manually recording the movie (that is, you did not select the Enable auto 
recording option in step 8) press the Print Screen key (or other designated capture key) to 
capture screen shots. 

Use the application as if you were demonstrating your actions to someone. If you have sound 
enabled on your computer and the option is activated, you will hear a camera shutter sound 
when screen shots are captured.

Note: When recording an onscreen action, it is best to perform the action more slowly than you 
would normally. For example, if you are recording keyboard action, type text in slowly. 

12. When you finish recording, press the End key (or other designated key) to stop recording.

The slides are generated and your new movie appears in Storyboard view. The audio files you 
recorded are assigned to the correct slide and saved as individual MP3 files. You can view the 
files in the Audio Library.

Tip: If you need to pause the movie recording process, press the Pause/Break key. To restart movie 
recording, press the Pause/Break key again.

Using the Captivate Timeline

The Timeline lets you organize objects and precisely control the timing of objects on slides. 
When you view the Timeline, you see a snapshot of a single slide and all of the objects on the 
slide. 

You have full control over when objects appear and can even specify that objects appear at the 
same time. For example, on a slide that contains a caption, a highlight box, and an animation, 
you can have the caption appear, then the highlight box 4 seconds later, and then the animation 2 
seconds after that. The Timeline also shows any audio associated with the slide or with objects on 
the slide, letting you easily coordinate the timing of audio with objects.
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The Timeline provides an easy way to view, at a high level, all objects on a slide and their 
relationship to each other. The major components of the Timeline are objects, the header, and the 
playhead. The objects on a movie slide are displayed as stacked bars on the left side of the 
Timeline. The header at the top of the Timeline indicates time in seconds (and parts of seconds). 
The playhead shows the point in time in which the slide is being viewed. 

Changing slide timing

The amount of time an individual slide appears is as important as the overall length of the movie. 
It is critical that your users have enough time to read and comprehend what is on the screen. You 
can make many changes to slide timing using the Timeline, but it is also useful to set an amount 
of time for the slide to appear.

Note: Slide timing cannot be shorter than the longest object. For example, if you have a slide with a 
caption that appears for 6 seconds, you cannot set the slide time for 4 seconds.

To change slide timing:

1. Open a Captivate movie.

2. Double-click on a slide whose timing you want to change.

3. If it is not open already, show the Timeline by clicking the splitter bar. To expand the Timeline, 
click the display arrow. 

4. The slide timing is contained in a Timeline object named "Slide." To shorten or lengthen the 
amount of time it takes for the slide to play, click the right edge of the Slide object until the 
resize pointer appears, and drag the edge to the left or right. Captivate shows the amount of time 
the slide will appear, in parentheses, next to the word Slide. The maximum amount of time a 
slide can appear is 1 hour (3600 seconds).

Changing object display order

Captivate allows you to add multiple objects, such as captions, highlight boxes, animations, or 
images to slides. You specify the order in which objects appear. The Timeline lets you precisely 
adjust the timing of all objects on a slide. 

The playhead shows the point in time 
in which the slide is being viewed.

Objects, such as captions, highlight boxes, click boxes, and audio files 
appear as stacked bars. They can be moved left and right on the Timeline.

The header at the top of 
the Timeline indicates 
time in seconds (and 
parts of seconds).
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To change object order using the Timeline:

1. Open a Captivate project. 

2. Navigate to the slide that contains the objects whose order you want to change.

3. If it is not open already, show the Timeline by clicking on the splitter bar. To expand the 
Timeline, click the display arrow. 

4. Change the order and timing of objects as required. 

For example, move the mouse over the left or right edge of an object on the Timeline until the 
resize cursor appears, then drag the edge left or right. This will change when and for how long 
the object appears. 
If you have an object that currently appears at the same time the slide appears, but you want a 
slight delay, move the mouse over the center of the object on the Timeline until the hand 
appears; then drag the entire object so the left edge aligns with 2s (a 2-second delay) or 4s 
(a 4-second delay) in the header.
In the example below, the arrow points to the left edge of the caption object bar aligned with 
the 2-second mark on the Timeline.

5. If you have two objects that overlap on the slide, you need to select the object you want to 
appear in front by setting the stacking order. Changing the stacking order consists of moving 
objects to the back and front of the slide "stage." The key point to remember is that objects at 
the back of the stage appear behind other objects. Use one of the following methods to set the 
stacking order.

■ In Edit view, right-click an object on the slide and select one of the object order options. If 
necessary, right-click other objects on the slide and adjust their order.
Bring to Front This option brings the selected object to the top. When the movie plays, 
the object appears on top of all others. 
Send to Back This option sends the selected object to the background. When the movie 
plays, the object appears behind all others. 
Bring Forward This option moves the object one layer forward. 
Send Backward This option moves the object one layer back.

■ In Edit view, on the Timeline, move the mouse over an object until the hand appears and 
drag the object up or down to change its position in the stacking order. Moving an object 
higher in the stacking order moves it to the front of the stage, while moving an object lower 
moves it to the back of the stage.
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In the example below, a text caption ("Click the File menu") is set on the Timeline to appear at 
the same time as an image (marquee.gif ). Because the text caption is higher in the stacking 
order, it will appear in front of the image if the two objects overlap on the slide. You decide 
how much of the text caption appears in front of the image by positioning the two objects on 
the slide.

Setting movie preferences

You can set a variety of movie preferences. Any preferences you select are for the currently opened 
movie only, enabling you to set different preferences for different movies.

Tip: If you want to set movie preferences and use those same preferences to create more movies in 
the future, you can do it easily. Simply create a blank movie, set preferences using the steps below, 
and then save the blank movie as a template. You can use the new template to create as many 
movies as you need. 

To set movie preferences: 

1. Open a Captivate movie. 

2. From the Movie menu, select Preferences. 

3. The Movie Preferences dialog box appears.

4. Click the Start and End tab.

■ Loading Screen This option displays a loading screen at the start of the movie. A loading 
screen might be useful if the first slide of the movie is large or contains audio and takes a few 
moments to appear. Click the More button to select an image.

Note: Captivate includes several loading screen images you can use, or you can create a 
custom image. To make a custom image available as a loading screen option, use Windows 
Explorer to copy and paste the image into the following folder: C:\Program files\Macromedia\ 
Captivate\Gallery\Preloaders. Supported formats are JPG, JPEG, GIF, PNG, BMP, ICO, EMF, 
WMF, and SWF. 

■ Password protect movie This option establishes a password that users must enter before 
being allowed to view the movie. Click the More button to set a password and write 
password messages for users.

■ Movie expiration date This option sets a date for the movie to expire. When a movie 
expires, it can no longer be viewed. 

■ Message line 1 This option lets you write an expiration message. The message appears if 
the movie has reached its expiration date (set above) and a user tries to view the movie. 
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■ Message line 2 This option lets you add a second line of text to the movie expiration 
message, if necessary.

■ Fade in on the first frame This option slowly fades the first slide of the movie in for 
users.

Movie end options:

■ Action Click the pop-up menu and select an action to take place at the end of the movie.
■ Stop movie This option stops the movie after it plays once.
■ Loop movie This option continuously replays the movie. (When the end is reached, the 

movie restarts.)
■ Close movie This option closes the browser window at the end of the movie.
■ Open URL or file This option specifies a URL or file to load at the end of the movie.

To load a URL, type the full path to a website (for example, http://.website.com). Click the 
pop-up menu to select the window in which the URL should appear; choose from Current, 
New, Parent, and Top. 
To load a file, click the More button, browse to the file, select the file, and click Open. Click 
the pop-up menu to select the window in which the file should appear; choose from 
Current, New, Parent, and Top. 

■ Execute JavaScript Select this option to run a specific piece of JavaScript code. Click 
More to enter the JavaScript you would like to execute.

■ Open other movie This option opens another movie at the end of the current movie. 
Click the More button, browse to the movie file (with the extension SWF, RD, or CP), 
select the file, and click Open. Click the pop-up menu to select the window in which the 
file should appear; choose from Current, New, Parent, and Top.

■ Send e-mail to This option opens the default e-mail browser and sends an e-mail message 
at the end of the movie. Type in the full e-mail address (for example, 
jdoe@companyzyx.com).

■ Fade out on the last frame This option sets the last frame of the movie to slowly fade out 
of view.

5. Click the Preferences tab.

■ Advanced movie compression This option compresses slide data that is shared between 
slides, thereby reducing overall file size. 

Note: In certain circumstances, compressed movies may not appear correctly when imported 
into Macromedia Flash. In such cases, do not select the advanced movie compression option. 
(When the compression option is not selected, file size increases.)

■ Compress compiled SWF file This option compresses the SWF file so it is smaller in 
size. A smaller SWF file is easier to play, open, and send through e-mail, especially on older 
computers. (Compressed SWF files can be used only with Macromedia Flash Player 6 or 
later earlier versions of Flash cannot play compressed SWF files.)

■ Include Breeze metadata Select this option if you are going to publish your movie to a 
Breeze server. This option creates three XML files that can help integrate a Captivate movie 
with Breeze.
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■ 508 compliance If you need to create Captivate projects that are Section 508 compliant 
and accessible for viewers with disabilities, select this option. Using this option, your project 
will be more readable by screen readers. 

■ Frames per second  This option sets the number of Flash frames that display per second. 
The default setting is 30 frames per second and is appropriate in most cases. For example, 
with the default setting, a caption that appears for 1 second, requires 30 Flash frames. 
Dividing the number of frames in a movie by 30 gives you the length of the movie in 
seconds. You may need to change the rate if you are embedding your Captivate SWF in 
another SWF file that has a frame rate different than 30.

■ Movie background color This option specifies the background color of the movie. 
Depending upon the type of slide and how screen shots were captured, the background 
color may not appear on all slides. Double-click the color box to open the Color dialog box 
and select a new color.

■ JPEG image quality Specifies the quality level for JPEG images. You can adjust this 
setting depending upon the images used in your movie. (Often, JPEG images are detailed 
and contain many colors, so greatly lowering their quality is noticeable.) Higher percentage 
values allow for high-quality images. Of course, this also increases file size. Change the 
quality by clicking the arrows to select a higher or lower number.

■ Audio quality Specifies the quality level for audio included in the movie. A higher quality 
setting increases file size.
Note: Selecting a higher quality setting for an audio file does increase the file size. However, at 
times, selecting a higher quality will not increase the file size dramatically, but will improve the 
quality of the audio significantly. Experiment with different audio quality levels to find the 
optimal setting.

■ Include mouse when movie is generated This option includes any recorded mouse 
movement in the movie.

■ Include audio when movie is generated This option includes any audio files that have 
been added to the movie.

■ Play tap audio for recorded typing when movie is generated This option plays tapping 
sounds in the final movie to represent recorded keystrokes. (For example, if you recorded an 
e-mail message being sent, you most likely typed an address to which the e-mail should be 
sent. The sound of the keys being pressed to enter the address was recorded and, using this 
option, a tapping sound can be played for each of the keystrokes.) 

6. Click the Playback Control tab.

■ Position Select the screen location for the playback control buttons. Click the pop-up 
menu and choose an option. 

■ Style Select the style for the playback control buttons. Style not only refers to the visual 
elements of the playback control buttons, but also the actual buttons that appear. Some 
styles include more buttons than others. When you click a style, the preview window shows 
the selected playback control.

■ Show progress bar (This option appears only if a playback control style that includes a 
progress bar is selected from the Style pop-up menu above.) Select this option to display a 
progress bar that shows users where there are (graphically) in a movie.
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7. Click the Background Audio tab.

■ Click the Play button to play the audio file.
■ Click the Stop button to stop playing the audio file.
■ Click the Delete button to remove the audio file from the click box.
■ Edit  Displays the Edit Audio dialog box. This dialog box lets you edit the audio file in a 

variety of ways, such as inserting silent periods and adjusting the volume.
■ Audio Displays the name of the audio file.
■ Record new Click to open the Record Audio dialog box. (Recording audio requires some 

basic equipment.)
■ Import  Displays the Import Audio dialog box. This dialog box lets you browse to an audio 

file and import it. 
■ Audio library  Click to open the Audio Library. The Audio Library lists all audio files that 

are already part of the currently open Captivate movie.
■ Fade in [#] seconds Specifies the number of seconds for the audio to fade in to full 

volume. Type a number or use the arrows to set a number.
■ Fade out [#] seconds  Specifies the number of seconds for audio to fade out to silence. 

Type a number or use the arrows to set a number.
■ Lower background audio volume on slides with additional audio Select this option to 

lower the volume of the background audio on slides that contain any additional audio files.
■ Loop audio Select this option to have the background audio file play continuously as the 

movie plays. This feature is useful if the audio file is shorter than the movie.
■ Stop audio at end of movie Select this option to stop playing the audio file when the 

movie finishes.
8. Click OK.

E-learning options

You can use Captivate to create truly interactive e-learning movies with full SCORM/AICC 
compliance. Captivate lets you do the following:

■ Create quizzes that automatically integrate with your LMS. Capture scoring data from all 
interactive elements, including click boxes, text entry boxes, buttons, and quizzes. Each 
interactive element can be assigned a weight, Objective ID, and Interaction ID for 
integration with an LMS.

■ Create a manifest file to better coordinate Captivate movies with your LMS.
■ Include a variety of question types in movies including multiple choice, true/false, 

matching, likert, fill-in-the-blank, and short answer. 
■ Use branching to customize content in response to viewer answers. Branching provides 

different paths for correct and incorrect answers.
■ Provide instant feedback to users through messages for correct, incorrect, and incomplete 

answers.

To access the eLearning options, select Quiz Manager from the Movie menu.
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Creating branching in Captivate movies

Branching is an important concept in creating effective e-learning materials. Branching 
(sometimes called "contingency branching") means that the path a learner takes through the 
program is determined by responses made to questions. It is an excellent method of 
individualizing learning materials. Branching may be made on the basis of correct answers to a 
question, wrong answers to a question, an option selected by the learner, or based on the learner's 
experience, job category, level, or any other category.

You can create smart and sophisticated branching in your Captivate movies. Listed below are a 
few easy ways to add branching to a movie. All of these options include the capability to score the 
results so they can be used individually or in combination with each other. Also, Captivate movie 
slides can contain multiple objects, so, for example, you could add a click box on a menu item 
and a button on a toolbar.

• Create question slides and specify different paths for right and wrong answers. This is the most 
straightforward method of adding branching. You have many options for answer paths 
including continuing the movie, going to a specific slide, or opening a URL. Captivate also 
makes it easy to add an error message for wrong answers and a retry message such as "please try 
again."

• Add click boxes and choose different paths if users click inside the click box or outside the click 
box. Click boxes have the same answer options as question slides, but can be incorporated into 
existing slides instead of requiring their own slide. This enables you to add branching and 
interactivity to your movies at the same time. Click boxes have other optional functionality 
including stopping slide audio when clicked, pausing the movie until clicked, and adding hint, 
success, and failure captions.

• Add text entry boxes and create different branches if users enter the text correctly or 
incorrectly. Text entry boxes are very flexible and can be used in many creative ways. For 
example, they are an excellent way to simulate data entry in an application. Because they are 
placed on existing slides and do not require their own slide, they do not interrupt the flow of 
the movie as much as a question slide. Text entry boxes have additional options such as 
requiring a password, adding case-sensitivity, and including hint, success, and failure captions.

• Add buttons and create different paths for when the user clicks the button or when they click 
outside the button. Buttons are a quick way to add branching and interactivity to your movies 
in a way that is comfortable for many users. You have complete control over what happens 
when users click the button such as advancing the movie, jumping to a certain slide, or 
opening an e-mail program. You can also design the button so it looks good in your movie by 
selecting the fill color, text options, transparency level, and border color. 
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Creating question slides

Captivate lets you create state-of-the-art e-learning movies. The powerful quizzing features make 
it easy to design many different types of questions such as multiple choice, short answer, 
matching, true/false, likert, and fill-in-the-blank. 

You have complete control over what happens when users answer questions correctly or 
incorrectly. For example, you can set one action (such as "go to the next slide") when a user 
supplies a correct answer, and you can set a different action (such as "Open URL or file") when a 
user supplies an incorrect answer. (This is commonly called branching.)

Measure student performance by using the reporting feature with any type of quiz. Track number 
of attempts, track correct and incorrect responses, and send pass/fail data to your LMS. You can 
also choose to provide students with feedback based upon correct or incorrect responses.

You can create six different types of question slides in Captivate:

• Fill in the blank
• Likert
• Matching
• Multiple choice
• Short answer
• True/False

Following is the procedure for adding a matching question. The process is similar for the other 
types of question slides.

Creating a new matching question slide

Select this option to create a question that provides users with two lists of items that must be 
correctly matched.

To create a matching question slide:

1. Open a Captivate movie.

2. Select the slide before where you want to insert a question slide. For example, if you want the 
new question slide to be slide 7 in the movie, click on slide 6.

3. From the Insert menu, select Question Slide.

The Question Types dialog box appears.
4. Select Matching and click OK.

5. Accept the default Title of the question or type new text directly into the text box. The title 
appears on the slide in the movie.

Tip: If you are creating many of the same type of question in a single movie, type in unique titles for 
each so they can be distinguished from one another easily.

6. In Question, type the matching question, exactly as you want it to appear on the slide, into the 
text box. For example, "Match the job titles in column 1 with the correct departments in 
column 2."
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7. In Answers, click Add under each column and type in the words or phrases to match. If 
necessary, click Delete to remove any answers or click the up and down buttons to move 
answers up or down a position in the column.

8. To establish the correct matches between answers, click an item in one column, then click an 
item in the other column, and click Match. A line is drawn between the two items to show the 
relationship. If you need to correct mistakes, click Clear Matches and start over.

9. In Numbering, click on the pop-up menu and select uppercase letters, lower case letters, or 
numbers.

10. Select the Options tab.

11. In Type, click on the pop-up menu and select if the question will be graded or is a survey.

12. In If correct answer and If wrong answer, use the pop-up menus to select what happens when 
the question is answered correctly or incorrectly. You have numerous options:

If correct answer: 
Jump to Select the desired action or destination after a user selects the correct answer. 
■ Go to previous slide Select this option to have the movie return to the previous slide. 
■ Go to next slide Select this option to have the movie proceed to the next slide.
■ Jump to slide Select this option to have the movie jump to a specific slide.
■ Open URL or file Select this option to have the movie jump to a specific URL on the 

Internet or to a local file. Click the pop-up menu to select the window in which the URL 
should appear; choose from Current, New, Parent, and Top.

■ Open other movie Select this option to have the movie begin playing a different movie. 
Click the pop-up menu to select the window in which the movie should appear; choose 
from Current, New, Parent, and Top.

■ Send e-mail to Select this option to open the default mail browser. 
■ Execute JavaScript Select this option to run a specific piece of JavaScript code. Click the 

More button to enter the JavaScript you would like to execute.
■ No Action Select this option to have success, hint, and/or failure messages appear, but no 

other action take place.

Note: When using the URL option, the URL is visible when you edit the slide in Captivate. 
However, it is not visible to the end user. If you want to show the URL to end users, you just 
create a simple image with the URL text on the image, add the image to your movie slide, and 
place a click box over the image.

Go to next slide Depending on the option you selected for Jump to, this box changes to let 
you specify an exact destination. 
Show correct message Select this option to provide a text message for users when they 
supply a correct answer. Clear this check box if you do not want to give any feedback for an 
correct answer.
If wrong answer: 
Allow user [#] attempts Use the arrows to select the number of attempts a user can try 
before another action takes place. 
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Infinite attempts Select this option to give users an unlimited number of attempts.
Jump to Click on the desired action/destination after the last attempt. You can choose from 
the options listed below. 
■ Go to previous slide Select this option to have the movie return to the previous slide. 
■ Go to next slide Select this option to have the movie proceed to the next slide.
■ Jump to slide Select this option to have the movie jump to a specific slide.
■ Open URL or file Select this option to have the movie jump to a specific URL on the 

Internet or to a local file. Click the pop-up menu to select the window in which the URL 
should appear; choose from Current, New, Parent, and Top.

■ Open other movie Select this option to have the movie begin playing a different movie. 
Click the pop-up menu to select the window in which the movie should appear; choose 
from Current, New, Parent, and Top.

■ Send e-mail to Select this option to open the default mail browser. 
■ Execute JavaScript Select this option to run a specific piece of JavaScript code. Click the 

More button to enter the JavaScript you would like to execute.
■ No action Select this option to have success, hint, and/or failure messages appear, but no 

other action take place.

Note: When using the Open URL option, the URL is visible when you edit the slide in 
Captivate. However, it is not visible to the end user. If you want to show the URL to end users, 
create a simple image with the URL text on the image, add the image to your movie slide, and 
place a click box over the image.

Go to next slide Depending upon the option you selected for Jump to, this box changes to 
let you specify an exact destination. 
Show error message Select this option to provide a text message for users when they supply 
an incorrect answer. Clear this check box if you do not want to give any feedback for an 
incorrect answer.
Show retry message Select this option to provide a text message for users when they supply 
an incorrect answer but there are remaining attempts available (e.g., Please try again).
Show incomplete message Select this option to provide a text message for users when they 
do not supply an answer (e.g., Please select an answer before continuing).

13. If you would like Clear, Back, and Next buttons to appear on the question slide so it is easier 
for users to navigate, select these options.

14. Select the Reporting tab and modify the following fields:

■ Report answers This option keeps a quiz score.
■ Objective ID This is an optional parameter. If the quiz question is related to an objective 

set in your LMS, enter the objective in this field.
■ Interaction ID If you want the Captivate movie (SWF file) to send tracking information to 

your LMS, you must use the Interaction ID specified by your LMS.
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■ Weighting Weighting signifies the relative importance of a question. You can enter any 
numeric value (without decimal). If all questions have the same value ("1", for example), 
they are scored equally. If you want to set different values for different questions, keep the 
following in mind: weights are relative to each other. So, a question with weight "2" has a 
value twice as high as a question with value "1". You can use this feature to give introductory 
questions a lower value and advanced questions a higher value.

■ Time limit Select this option to set a time limit for how long users have to answer the 
question. In the text box, type in the amount of time in hours:minutes:seconds format.

15. When you finish, click OK.

The new matching question slide appears in the designated location in the movie. If you need 
to make any changes, click Edit (in the upper-left corner of the slide).

Creating a manifest file

Captivate contains an important e-learning feature that creates a manifest file. If you want to 
package a Captivate movie to be an e-learning course that can be administered and launched from 
a SCORM 1.2 or 2004 conformed LMS, you need a manifest file.

The manifest file that Captivate creates is named imsmanifest.xml and contains references to all 
content resources. The XML file uses predefined XML tags to describe the package components, 
structure, and special behaviors. 

To create a manifest file:

1. Open a Captivate movie. 

2. From the Movie menu, select Quiz Manager. 

The Quiz Manager dialog box appears.
3. On the Reporting tab, select Enable output options.

4. Select SCORM.

5. Click Manifest.

6. Set the SCORM Version by clicking on the pop-up menu and selecting 1.2 or 2004.

7. Set manifest options.

Course options: 
■ Identifier The identifier is used by the LMS to identify different manifests. A default 

identifier based on the name of your Captivate movie is automatically added to this field. 
You can change the identifier at any time by selecting the text and typing in new text. 
(Required field) 

■ Title The title can be viewed by students using the LMS. A default title based on the name 
of your Captivate movie is automatically added to this field. You can change the title at any 
time by selecting the text and typing in new text. (Required field)

■ Description Text used by the LMS to describe different courses to learners. A default 
description based on the name of your Captivate movie is automatically added to this field. 
You can edit the description at any time. (Required field) 
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■ Version The version specifies a number that can be used to differentiate manifests with the 
same identifier. (Required field)

■ Duration Select this option to specify the approximate time it takes to work with this 
particular Captivate movie. Set the time in the following format: hh:mm:ss (Optional field)

■ Subject Select this option to write a short description of the Captivate movie using 
keywords or phrases. (Optional field)

SCO options: 
■ Identifier The identifier is used by the LMS to identify different Shareable Content 

Objects (SCO). A default identifier based on the name of your Captivate movie is 
automatically added to this field. You can change the identifier at any time by selecting the 
text and typing in new text. (Required field)

■ Title A default title based on the name of your Captivate movie is automatically added to 
this field. You can change the title at any time by selecting the text and typing in new text. 
(Required field)

■ Mastery score Select this option to specify a passing score for the Captivate movie. The 
score should be a number between 0 and 100. Only Captivate movies containing score-
reporting objects such as quiz slides, text entry boxes, click boxes, or buttons, need to 
include a mastery score. (Optional field)

■ Time allowed Select this option to specify the maximum amount of time allowed to 
complete the Captivate movie. (Optional field)

■ Time limit action Select this option to specify the action that should be taken when the 
maximum time allowed to complete the movie has been exceeded. Click the pop-up menu 
and select one of the four options: Exit with message, Exit without message, Continue 
with message, or Continue without message. (Optional field)

■ Launch data Select this option to specify initialization data expected by the resource. 
(Optional field)

8. Click OK.

The manifest file is generated. To see the manifest file, you should publish your Captivate 
movie and create a SWF file. Then, if you used the default save location, you will see the SWF 
file and imsmanifest.xml file in your My Documents\My Captivate Projects folder.

Note: If necessary, you can create a PIF file that packages the Captivate movie output files and 
manifest file (with additional files if you are using the SCORM 2004 option) together. For details, see 
the online help.
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Publishing movies

After you create a project, you publish your project so others can view the movie. Captivate 
contains many publishing options and after you create a movie, you can publish the movie in as 
many different formats as you require.

• Publishing movies as EXE files
• Publishing movies as Flash files
• Publishing movies as handouts (Word file)
• Publishing movies to the web using FTP
• Sending movies using e-mail

Following are the procedures for publishing a movie as a Flash file, publishing to a Breeze server, 
and publishing handouts.

Publishing movies as Flash files

You can publish Captivate movies as Flash SWF files and then use these Flash files independently 
or include them in web pages. 

To publish a movie as a Flash file (SWF): 

1. Open a Captivate movie.

2. From the File menu, select Publish.

3. In the Publish dialog box, select Flash (SWF).

4. In Movie Title, enter the desired name without the file extension (SWF).

5. In Folder, enter the full path for the folder in which to save the file or click Browse to locate the 
folder.

6. Select from the following output options:

■ Zip files This option creates a ZIP file containing the Flash (SWF) file. (A program like 
WinZip can be used to open the files.)

■ Full screen This option opens the Flash file in full screen mode. 
■ Export HTML This option exports the HTML code necessary to add the Flash file to a 

web page.
7. The Movie information area (visible in Storyboard view) displays useful statistics about the 

movie including the size (resolution), number of slides, audio information, eLearning details, 
and the playback control assigned to the movie. To change many of the options listed in this 
area, click Preferences.

8. When you are done, click Publish.

Publishing movies to a Breeze server

Deliver Captivate simulations and demonstrations through standard web browsers. Macromedia 
Breeze users can publish Captivate projects directly to a Breeze server.  
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To publish a movie to a Breeze server: 

1. Open a Captivate movie.

2. From the File menu, select Publish.

3. In the Publish dialog box, select Breeze. 

4. Click Change Server. 

The Breeze servers dialog box appears.
5. Click Add. 

6. In Name and URL, type the name and URL of the Breeze server you want to use. 

7. Click OK.

The Breeze server is now listed.
8. Select the server you just added and click OK.

9. Click Publish.

10. Sign in to Breeze using your login and password.

11. Select a location to store the Captivate movie

12. Click Publish to This Folder.

13. Fill in correct content and speaker information. You must specify a title for the movie, a 
language, and a speaker name. When you are finished, click Next.

14. (Optional) Click Customize to set Breeze options, such as permissions.

15. Click Next.

A dialog box appears and confirms that the project was successfully published to the Breeze 
server you specified. 

16. Click OK.

17. Click OK again.

Publishing movies as handouts

You can publish Captivate movies as handouts in Microsoft Word format. A Captivate movie is 
published into a Word document as individual slides.

Note: Microsoft Word must be installed on the same computer as Captivate in order to publish 
movies as handouts.

To publish a Captivate movie as a handout: 

1. Open a Captivate movie.

2. From the File menu, select Publish.

3. In the Publish dialog box, select Handouts.

4. In Movie Title, enter the desired name without the file extension (DOC).

5. In Folder, enter the full path for the folder in which to save the file or click Browse to locate 
the folder.
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6. Select from the following output options:

■ Select an export range The export range is made up of the slides that you want to export 
to Word. You can select All slides, only the Current slide, only the current Selection, or a 
range of Slides.

■ Use tables in the output Select this option to set the number of slides that should print on 
each page.

■ Slides per page Specifies the number of slides to print on each page of the Word 
document. A small thumbnail image to the right shows a preview of the page layout 
selected.

■ Caption text Select this option to print the text of captions underneath the slide on which 
they appear. For example, if slide 2 of the movie contains a caption, the text on the caption 
will print below the slide when the movie is converted to Word format.

■ Add blank lines for notes Select this option to print blank lines under each slide of your 
movie on the Word document. This option is appropriate if you are using your Word 
document as a printed handout and want to supply your users with an area in which they 
can take notes.

■ Slide notes Select this option to include slide notes in your Word document. These notes 
are usually not seen by users (those who view your movie), but are an organizational tool for 
Captivate authors. (For more information about slide notes, see the online help.)

■ Include objects (text captions, images, etc.) Select this option to include objects on 
slides such as captions, images, click boxes, or highlight boxes.

■ Include hidden slides Select this option to include any slides you have marked as hidden 
in your movie. (Hidden slides do not appear when the movie is viewed.)

■ Include Mouse Path Select this option to include any mouse paths that appear on slides.
7. When you are done, click Publish.

Microsoft Word opens with the new movie document. You can make modifications and save 
the file as desired.

Note: The DOC file is created using a Microsoft Word template named Captivate.dot. This template 
contains a header with the date and a footer with page numbers. If you want to change or remove the 
information in the header or footer, you can edit the DOT file by opening it in Word. When you install 
Captivate, the Captivate.dot template is automatically placed in the program folder, located by default 
at C:\Program Files\Macromedia\Captivate. 
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Exporting from Captivate to Flash

From within Captivate, you can select the Flash export option to export a Captivate movie into 
Macromedia Flash MX 2004 for additional enhancement, scripting, or integration into a larger 
project. 

Note: You must save your Captivate movie before exporting. (The easiest method is to click the Save 
button on the toolbar.)

To export a Captivate movie into Flash:

1. Open the Captivate movie you want to export.

2. From the File menu, select Import/Export > Export the movie to Flash MX 2004.

If you have not saved your project yet, a prompt appears. Click Yes and select a file name and 
location for the project.

3. A message appears, asking if you would like to open Flash. Click Open Flash MX 2004.

4. The Save As dialog box appears. Accept the default file name and location for the new FLA file, 
or change the name and location as necessary.

Note: It can be important to save the FLA file in the same directory as the CP file. If you have any 
animations in your movie, the animations are exported to the same directory as your CP file. The 
animation SWF files must be in the same folder as the main SWF file in order for the animations to 
display properly in the published SWF file.

5. Click Save.

6. A dialog box appears and provides instructions for importing into Flash. Click OK.

Flash starts with a blank FLA open.
7. From the File menu, select Import > Import to Stage or Import > Import to Library. (The 

Import to Library option imports the Captivate CP file into the Library as a movie clip.)

8. Navigate to the Captivate project (CP) file, select it, and click Open.

The Captivate Options dialog box appears.
9. Select the Captivate movie options to import.

10. Click Import.

The Captivate project is imported onto the Flash stage or Library. Now you can begin editing 
your Captivate movie in Flash.

11. When you finish, save the new Flash project (FLA file).
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APPENDIX
Keyboard shortcuts
Shortcut keys can provide an easier and quicker method of navigating and using Captivate by 
enabling you to use keyboard key combinations instead of a mouse or program menu. Shortcut 
keys are commonly accessed by using a keyboard "F" key, Alt, Ctrl, and/or Shift in conjunction 
with a single letter or number.

Shortcut key Action

F1 Open Captivate Help (To access dialog-level help, click the Help button 
on individual dialog boxes.)

F3 Test view current slide (Edit view only)

F4 Preview movie

F5 Record audio 

F6 Import audio

F7 Spelling and grammar check 

F8 Preview movie from current slide 

F10 Preview current slide and following four slides 

F11 View Captivate in full screen

F12 Preview movie in web browser

Control+A Select all

Control+C Copy (slide in Storyboard view or Filmstrip, and selected object in Edit 
view) 

Control+D Duplicate (slide in Storyboard view or Filmstrip, and selected object in 
Edit view)

Control+E Extend length of object display time to end of slide on Timeline (Edit 
view only)

Control+H Change slide to high quality 

Control+I Increase indent (selected object in Edit view)

Control+J Change slide to JPEG quality
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Control+O Open project

Control+P Align selected object with playhead on Timeline (Edit view only)

Control+S Save

Control+V Paste what is on the clipboard (e.g., slide, image, object, etc.)

Control+X Cut (selected object in Edit view)

Control+Y Redo

Control+Z Undo

Shift+Control+A Add animation object (Edit view only)

Shift+Control+B Add new button (Edit view only)

Shift+Control+C Add new caption (Edit view only)

Shift+Control+H Hide/Show slide

Shift+Control+I Decrease indent (selected object in Edit view)

Shift+Control+K Add new click box (Edit view only)

Shift+Control+L Add new highlight box (Edit view only)

Shift+Control+M Add new image (Edit view only)

Shift+Control+O Add new rollover image (Edit view only)

Shift+Control+P Publish

Shift+Control+R Add new rollover caption (Edit view only)

Shift+Control+T Add new text entry box (Edit view only)

Shift+Control+X Add text animation (Edit view only)

Spacebar Test view current slide (Edit view only)

Shortcut key Action
44 Appendix:  Keyboard shortcuts



INDEX
A
Accessibility  6,  31
AICC  5,  6,  32
Audio

about  24
background  32
editing  6
gallery  24
importing  24
library  32
quality  31
recording  25

Authorware  5

B
Background

audio  24,  32
color  31

Boxes
click  18
highlight  17
text entry  21

Branching  33
Breeze

metadata  30
placing Captivate movies in  6
publishing to  39

Buttons  33

C
Captions  15
Capturing movies  5
CDs  5
Click boxes

adding  18
branching  33

Color (background)  31
Compressing movies  30
Contingency branching  33

D
Demonstrations  5
Documentation (Captivate)  7

E
E-learning

about  32
branching  33
question types  34

E-mail  18,  30,  39
Edit view  12
Environment (Captivate)  11
EXE files  5,  39

F
Fade effect  30
Features  5
Flash (editing Captivate movies in)  6,  42
Flash files  5,  39
Frame rate  31
FTP  39

G
Gallery  29

H
Handouts  6,  40
Highlight boxes  17
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I
Images  31
Interaction ID  36
Interactivity

click boxes  18
e-learning  32
question slides  34
text entry boxes  21

J
JavaScript  30,  35,  36
JPEG  31

L
Learning Management Systems (LMS)  5,  32,  34,  37
Loading screen  29
Looping movies  30

M
Manifest file  32,  37
Menus  12
Microsoft Word  6,  39,  40
Mouse movement  31
Movies

compressing  30
creating  11
editing  14
editing in Flash  42
end  29
expiration date  29
looping  30
publishing  39
recording  12
security  29
start  29

MP3 files  24
Music  24

N
Narration  24

O
Objective ID  36
Objects

captions  15
click boxes  18
highlight boxes  17
text captions  15
text entry boxes  21

Online help (Captivate)  7

P
Passwords (for movies)  29
Playback controls  31
Preloaders  29
Previewing  5
Progress bar  31
Publishing

Breeze server  39
Flash files  39
handouts  40
movies  39

Q
Quality

audio  31
images  31

Question slides
branching  33
creating  34
weighting  37

Questionmark Perception  5
Quizzing

adding  34
e-learning  34
matching questions  34
question types  34
weighting  37

R
Recording

applications  13
audio  24,  25
movies  12

Requirements  9
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S
SCORM  5,  6,  32,  37
Simulations  5
Slides

preview  5
thumbnails  11
timing  27

Sound
about  24
background  32
editing  6
gallery  24
importing  24
library  32
quality  31
recording  25

Storyboard view  11
Support (Captivate)  7
System requirements  9

T
Technical Support (Captivate)  7
Text captions  15
Text entry boxes

adding  21
branching  33

Thumbnails  11
Timeline

about  5,  12,  26
objects  26,  27
slides  27

Toolbars  12

U
Unicode support  6

V
Voice-over  24

W
WAV files  24
Weighting  37
Word  6,  39,  40
Work environment  11
Index 47
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